ARRIA 10 DAC38RF82 JESD REFERENCE DESIGN USER
GUIDE
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|. DESCRIPTION

The design “A10_DAC38RF82_7p68G_84111.qar” is developed for ArrialO development
kit ( ) for the mode: 84111 with lane rate 7.68 Gbps. It has JESD Base IP and
JESD PHY IP to send DAC data (Sine wave 20MHz) to the DAC through JESD interface.
The design has a simple transport layer specific for that mode (84111) that receives the
samples generated by the DDS compiler in firmware and re-order the bits and gives out 16
samples every clock cycle. The results can be verified using Chipscope or using a Scope (or a
spectrum analyser). This document gives a brief on the compilation and verification process
involved.

NOTE: This version of the FW is a fixed line rate firmware and hence will work only at
7.68G. For any other line rate the firmware needs to be recompiled for that specific linerate.

Following are the inputs required by the design and the outputs that user can make use of in
their custom modules

Signals Description Direction
device clk reference clock from DAC38RF82
mgmt_clk 100MHz internal clock
global_rst_n Active Low User reset Input
sysref SYSREF Signal
Tx_sync_n SYNC signal
tx_serial_data Serial Data to DAC Output
jesd204_tx_link_data Transport Layer data out (16 samples for every link | oytput from the

clock) transport

jesd204_tx_link_valid | SOMF aligned with rx_dataout module

NOTE: As in DAC38RF82 SYNC pin is not exposed to any connector other than FMC the
actual testing is performed with DAC38J82 with lane rate 7.3728G.


https://www.altera.com/products/boards_and_kits/dev-kits/altera/kit-a10-gx-fpga.html

1. COMPILING QUARTUS PROJECT

1. Restore the Quartus project

Open Quartus 16.1. Click File -> Open and choose the qgar file
“A10_DAC38RF82_7p68G_84111.gar”
Click OK in the dialog box that pops up next

\_s Restore Archived Project @

Archive name:
\Ref Design 4T4R\Testing\020118\A10_DAC38Rf82_7p68G_84111.qar | |
Destination folder:

design 4T4R(Testing/090118/A10_DAC33Rf32_7p638G_5841117_restored I = I

Owverwrite any existing files in the destination folder

OK l Cancel H Help ‘

Quartus will restore the contents to A10_DAC38RF82_7p68G_84111 restored folder in the
same location as that of gar file. User can change the location or the name of the folder.

2. Compiling the project

In Quartus IDE (environment), go to Project Navigator window located left side. This will
show the device for which the firmware was compiled and the hierarchy of Verilog modules
used.

Tasks window right below the Project Navigator will list all the tasks involved in compiling a
design. To compile the project, double click “Compile Design” and all the subtasks listed will
be executed in sequence

This will generate a “.SOF file” in the following location
Relative path of the example design +

“\A10 DAC38RF82_7p68G_84111 restored\prj\output_files”
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Once the SOF file is generated, proceed to next section. It will take 15 min approximately to

170191 2017
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11888 2017..
170193 2017

Time Message
170190 2017

Fitter placement preparation operations ending: elapsed time is 00:00:59
Fitter placement operations beginning

..Fitter placement was successful

Fitter placement operations ending: elapsed time is 00:00:25
Total time spent on timing analysis during Placement is 21.58 seconds.
Fitter routing operations beginning

compile the design

I11. VALIDATING WITH DAC38RF82

1. Configure DAC

e The reference clock from DAC should be stable before downloading firmware. So,

the DAC has to be configured first before we program the board.
e Open DAC38RF82 GUI v2p0 and perform the follow actions:

o Reset the DAC. Toggle the Reset Pin.

o Load the Default Register Settings.

o Set the following values:
= DAC Clock Frequency: 6144 Mhz
= #0of DACs: Dual DAC
= #of 1Q pairs per DAC : 1 1Q pair
= # of serdes lanes per DAC : 4 lanes
= Desired Interpolation : 8x

=  Check the PLL enable checkbox for On-chip PLL

o Press the Configure DAC button.




o Presson PLL Auto tune
o Finally press on Reset DAC JESD Core & SYSREF TRIGGER.

[l DAC33RFEx EVM
Fle Debug Settngs Help

DAC38RFxx EVM GUI v2p0
| Quick Start | DAC38RF8x | LMK04828 ELowtevelv

Die Temp (Celcus)
0 DAC38RF82

[ & Reconnect?

SELECT DEVICE

l

OAC RESETE Pin Quick Start Procedure
-Reset the DAC. Toggle the RESET pin.
Hot n RESET LOAD DEFAULT -Load Default Register Settings.
-For Extemal clock mode, enter the
external cock frequency and
DAC MODE select the desired no. of DACS,
p— — no. of 1Q pars, no. of serdes anes
DAC Clock Freguency (MHZ) #of DACs #of 10 paks per DAC  # of gerdes lanes per DAC  Desired n and the nterpolation.
6144 Dual DAC |- 110 paic [=] |4Lanes - Ex j CONFIGURE DAC -Clck on CONFIGURE DAC button
to configura the DAC for the mode

selected
Valid PLL Frequency

On-chip PLL
PLL Enable [

ula allxg [ofFrea (NHz) serdes Configured to Full Rate Reference frequency, M and N
= x 334 Serdes dock prediider = 4 divider vales.
LR Serdes PLL Wrange = 1 -Selact the desirad mode of the DAC
Serdes PLL Multipier = 5 and chck on the Configure DAC
SMA J4 CLK |35, HSDCPRO ini fie: DACIBRFBx_LMF_841 button.
(MHz} -Ciick on the PLL AUTO TUNE

Current Serdes Lane Rate =7680.00MHz
Maximum sample rate for Dual DAC,1 IQ pai,4 Lanes,8x interpolstion & 9000

-For onchip PLL mode,check the
PLL Enable box and specfy the

button to automatically set the PLL
loop fiter voltage

-Reset the DAC JESD Core and trigger sysref

Reset DAC
JESD Core & SYSREF

~ HARDWARE CONNECTED ‘Q} TEXAS INSTRUMENTS

Programming Arria 10 development kit

Connect USB Blaster to Arrial0 development kit. Go back to Quartus project, and double click
Program Device in tasks window. This will open the programmer tool.

Click on Auto Detect and choose “10AX115S2E2” in the Select Device window and click OK
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Right click on “10AX115S2E2” in the JTAG chain and choose Edit-> Change File. Browse
and select the .SOF file generated in previous section
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Check the Program/Configure box and click start. Progress bar should start incrementing
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3. Checking Results in Signal Tap

Once the development kit is programmed, user can view the results in Signal Tap which probes
signals from the kit using USB blaster and JTAG interface. It can be opened from Quartus
Tools-> SignalTap Il Logic Analyzer
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Signals which are currently probed are

e tx_sync_n — Active low SYNC signal to JESD Base IP. If SYNC is established, this
signal will be high

e sysref- SYSREF signal to Base IP

e jesd204_tx_pcs_data — 256 bit pcs data from JESD Base IP (grouped into 8 lanes of
32 bit each)

e jesd204 tx_link_data - A 256 bit bus of data coming from the Transport layer. It
contains sixteen 16-bit samples in each clock cycle.

e ddsiO|fsin_o, ddsil|fsin_o, .. ddsi3|fsin_o- The 16 bit output samples coming from
each DDS compiler (see Firmware Information section).

e jesd204_tx_link_valid - Data wvalid signal aligned with transport layer
jesd204_tx_link_data.

Other signals can also be probed. Each time, signals are added/removed from signal tap, the
project has to be compiled again



Following is the Signal Tap window. Hardware and Device tabs

properly

should be selected/listed

instance Manager: [ [5)] (=

[BD] Ready to acquire

Large NA

Instance Status Enabled  LEs: 7159 Memory: 237158 Small: NA Medium: NA
auto_signaltap_0 MOt FunNIng [ 7159 cells 2371584 bits NA NA NA
trigger: 2018/01/03 00:4133 | Lock mode: [ < Allow all changes

Node Data Enabic | Tngger Enabic | Trigger Condmions
Type| Atias Name s7e 373 [1[¥[Basicano -
[ sysref | [C4] 3] | x
£ tx_syncn ] 2]
- =1 xcvr_jesd_tei0_xevr_jesd_te|jesd204_tx_pes_data[255.0] | = = | AND
=3 # xevr_jesd_tei0_xcur_jesd_tx|jesd204_tx_pcs_data[255.224] | 7] 3] | sooomoxxxn
- 4 xevr_jesd_tei0_xcur_jesd_tx|jesd204_tx_pcs_data[223..192) | (4] [Cd] | sooxxxxn
- + wewr_jesd_teiO_xcvr_jesd_tx|jesd204_tx_pecs_data[191..160] | =1 &) | RHRRARKK N
- * xcwr_jesd_txi0_xcwr_jesd_tx|jesd204,_tx_pcs_data(159..128] [E] ] [ ooooooom
. ¥ wevr_jesd_teiO_scwr_jesd_tx|jesd204_tx_pcs_data[127..96] | =1 ] | ooononon
3 # xevr_jesd_t<i0_xcvr_jesd_tx|jesd204_tx_pcs_data(95..64] | [E]] = | oooooooth
- + xevr_jesd_teio_xewr_jesd_tx|jesd204_tx_pcs_datal63.32) | = 3] | oooooooi
- * - xevr_jesd_oei0_xevr_jesd_tx|jesd204_tx_pes_data[31..0] = = HHHXHHXNX T
= _ayer_DAC38RFS2_84111jesd_transporti|jesd204_tx_link_data(255.0]  [¥] = | AND
4 _C38RFB2_84111:jesd_transportl|jesd204_tx_link_data[255.224]| [ 3] | sooomxxxn
+ . C38RFB2_84111jesd_transport1|jesd204_tx_link_data[223..192]| [C4] [Cd] | soomn
# ..C38RFB2_84111 jesd_transport1|jesd204_tx_link_data[191..160]| [E3] & | ooooooom
= ¥ . C3BRFB2_84111;jesd_transport1|jesd204_tx_link_data[159..128]| ] = | ooooooom
- ¥ _C3BRFB2_84111:jesd_transport|jesd204_tx_link_data[127.96] | [E2] = | ooooonon
3 + _AC38RF82_84111jesd_transport1|jesd204_te_link_data[95.64] | = & | oooooooh
F # _AC38RF82_84111:jesd_transport|jesd204_tx_link_datal63..32] = = MK
+i . DAC38RF82_84111:jesd_transport1|jesd204_tx_link_data[31.0] | = [E]] [ sooooeah
altera_jesd204:u_jesd204|jesd204_tx_link_valid | (] ] |
=3 4 _ort_layer DAC3SRFS2_84111:jesd_transport]|dds:ddsio|fsin_o[15.0] | [ ] oo
- # _ori_layer DAC3SRFS2_84111 jesd_transporil|dds ddsi1|fsin_o[15.0] | [C3] ] | xxx%h
- ¥ .o _layer DAC38RFS2_84111;jesd_transportl|dds:ddsi2|fsin_o[15..0] | [E3] & | xxxh
) ) _ort_layer_DACIBRF82_84111;jesd_transport]|dds:ddsi3|fsin_o[15..0] [E1] = xx¢%h

If Hardware or device is not listed,

blaster is connected

Instance Manager: [T (D] (=

Ready to acquire

> | JTAG e -

=

Hardwad |USB-Blasten [UsB-2)

Device:

Signal Configuration:

Clock: port_layer_DAC38RFB2_84111:jesd_transport? |
Data

=] (]
@1: 10AT11551 ox02€08000; ~ | ||

SOF Manager. S0110/]e50203
(22] soFmenzger =] (BT sorieresasoet.

nie_ctie [

Sample depth: [4K ¥ | RAM type: [Aute

[ Segmented: |2

2 K sample segments

Nodes Allocated: @ Auto @ mManual: 579

e |7

Storage qualifier:

Type  [BHcontinuous

Input port: |auto_stp_external_storage_qualifier

Nodes Allocated: @ Auto Manual s79
Record data discontinuities

Disable starage qualifier

Trigger
Nodes Allocated: @& Auto €

e

Trgger positon: | % pre mgger positon

Trigger conditions: |1

() Triggerin
Pin

@ Node:

* | JTAG Chain Configuration: JTAG ready

ed.sof

setup

fean chain

x

click on Setup and choose the right port to which USB

=

x

Instance Status Enabled  LEs: 7159 Memory: 237158 Small: NA Medium: NA Large: NA L‘ﬁ"' r—— 'I m
[®] auto_signattap_o Not running. = 7159 cells 2371584 bits NA A A
Device: @1 10AT11851 | | sean chain
o) 50 mansger: (@) () Bo318/jesdz0ab, cdaor
wizser 2018/01/03 004133 &0 Lock mode: [ = Allow all changes -] Signal Configuration:
Node | pata Enabte | Trigser Enabie | Trigser
= — [ — B r— Clock: sort_layer DAC38RFB2_84111:jesd_transport|tx_tink_clic [ |
- sysref 3] = | > Data
[g— ] = | = =] e = =
- = xevr_jesd_txi0_xcvr_jesd_tx|jesd204_t<_pcs_datalq tyr= (Aute
- * xewr_jesd_txi0_xcvr_jesd_tx|jesd204_tx_pcs_f 2 2 K sample segrents .
- * xevr_jesd_beiO_xcvr_jesd_txljesd204_tx_pcs_|
L Hardware Settings | JTAG Settings :
- * xevr_jesd_teiO_xcvr_jesd_txljesd204_tx_pcs_| & ng= | Manual: s79 :
- * xcvr_jesd_ti0_xcwr_jesd_tx]jesd204_tx_pcs | | Selecta programming hardware setup to use when prog: & devices. This prog € P -]
+ xevr_jesd_teiO_xcwr_jesd_tx]jesd204 tx pes | | hardware setup applies only to the current programmer window.
# xevr_jesd_bei0_xcvr_jesd_tx|jesd204_tx_pcs_|
* xcwr_jesd_teiO_xcur_jesd_txljesd204_tx_pcs_{ | Curently selected hardware:
¥ xevr_jesd_toiO_xcwr_jesd_tx]jesd204_tx_pcs_| Avaiabie rettems | Ne Hardware
- S . ayer_DAC38RFBZ_84111jesd_transport] [jesd204) Use-Blastert (USB-1] o_stp_external_storage_qualifier
F = S— USE-Blasterll [USB-2 =
= It ® auto Manuat  [579 s
= USE-Blaster! Local use-1 = s
+ ..C3BRFB2_84111jesd_transport1 |jesd204_v] USE-Blaster! Local use-2 Ui discontinuities
+ _.CIBRFB2_84111jesd_transport] [jesd204_t| I
# _C3IBRFB2_84111jesd_transport |jesd204_t| il
# _AC3BRFB2_84111;jesd_transport1|jesd20:
+ _AC3BRFS2_84111jesd_transport|jesd204 |
¥ . DAC38RF82_84111 jesd_transport1]jesd204 o £ ey . z
altera_jesd204-u_jesd204]je=d204_tx_link_valid
* _ort_layer DAC38RFS2_84111:jesd_transport1|ddd — ot | Sequential |
1 _ort_layer DAC3BRFS2_84111;jesd_transport1|dd = = - =
# _ort_layer_DAC38RFS82_84111 jesd_transport1|dds — - = Ingger positio
 ..ort_layer DAC38RFE2_84111:jesd_transport1|dds-ddsi3|fsin_o[15.0] xR Trigger conditions: 1 =)
1 Taggerin
Pin
® hode
o

"MK‘SQND




Select auto_signaltap_0 and Click on Run Analysis
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“Refer DAC38RF82 Datasheet for more details
The transport layer is implemented only for the mode 84111
From the DAC datasheet, the sample format can be obtained as follows

Sample Pattern for one frame of 84111

Table 12. JESD204B Frame Format for LMFSHd = 84111

Nibble 1 | 2
lane RX0 A-io[15:8]("
lane RX1 A-i0[7:0]@
lane RX2 A-qO[15:8]
lane RX3 A-qO0[7:0]
lane RX4 B-i0[15:8]
lane RX5 B-i0[7:0]
lane RX6 B-q0[15:8]
lane RX7 B-q0[7:0]

STP signals for 84111, 7.68G Lane Rate



\og: TriE @

017/12/28 071832 (00309 elapsed)

Type

Alias. Name

rx_sysref

tx_sync_n

xcvr_jesd_mci0_xcvr_jesd_rx|jesd204_tx_pcs_data[255..0)

¥ xcwr_jesd_nciO_xcvr_jesd_ndjesd204_tx_pcs_data[255..224]

# xcwr_jesd_nciO_xcvr_jesd_ndjesd204_tx_pcs_data[223..192]
.180]
.128)

.s6]

xcvr_jesd_rciO_scvr_jesd_ndjesd204_tx_pcs_data(191
)_xcvr_jesd_rx|jesd204_te_pcs_data(159.
)_xcwr_jesd_rx|jesd204_te_pcs_data(127

)_xevr_jesd_rx|jesd204_tx_pes_data(63..32)

]!

xevr_jesd_nci0_xcvr_jesd_rx|jesd204_ts_pcs_data[31..0]

-ayer_OAC3oRF02 64111 jesd_transport [jesd204_tx_link_data(255..0]

D3COAESFh CBDEF308h
9B525870N X 640003 4AN X_1225ECE1h X AFECFA3Ch X 239FB1Cah X_FCECBADFN X D7CABCE1N X EBD67345h X 00B74C34h X ORSACZBFD
{ags4sBesh X p3geaarCh X DACOAESFh X 2510FBEZh X 885A4A38N X 7F7EZA72h X 626677700 X 1C304354h X CBDEF208h X EFRAASBEN

ookl lolo ookl ulells

altera iesd204:u iesd204liesd204 tx link valid

.C3BRFB2_84111;jesd_transport1 |jesd204_tx_link_datal255..2241¢ Czpisrzan X_DEBBECECH u1acc.p,nm{mmwjm n
= caewaz_aunma_n-.nspomuesdzo-_m_lmk_dmlzzz.wz]{z:raw sh 727A7EZFN X 707766620 X 5443301Ch X OBFIDECEN scs10001n X acarsAann X BeCBDFFAN
*...C38RFB2_B4111:)esd_transport|jesd204_tx_link_data[191..160] { 30FaE04in X czB18F2an X _DFsaEcEch X @18cCan7n X 457306680 X 3s4Cn706n X BF62sA00n X_BEB001BEN X DAI18EACh X 065308800
# . C38RFB2_84111:esd_transport]|jesd204_tx_link_data[159..128] (£zFB1025n 727A7E7Fn X 70776E62h X 5443301Ch X 08F30DECHN s8ca180a1h X acareAaan X BeCBDFFan
# .. .C38RFB2_84111:jesd_transport|jesd204_tx_link_data[127..96] { 30FAE0afn X CzB19F23h X_DFBaECECh X 81BCCaD7h X 457306E8h X 334CB706h X BF625A09h X_BEBO01BEN X DA318EACh X 065308800
# . AC38RF82_84111jesd_transport1|jesd204_tx_link_data[95.64] { EzFBiozsn 727A7E7ih X 7D770E62h X 5443301Ch X 0BF3DECHR h X aca1s0a1h X acaFeasan X BeCBOFFan
# _AC38RFS2_84111jesd_transport!|jesd204_tx_link_data[63.32] { 30FAF0aFn X C2B19Fzah X_DFeaECECh X a1BCCaD7h X a573D0ken X 3saCBzoch X BFozsAosh X_BFBo01BEN ¥ DA218EAGh X.oos20890h
+ _DAC3SBRFS2_84111jesd_transportl|jesd204_tx_link_data[31 0] {EzFB1025h ¥ _384AsAcah X_727A7E7Fh X_7D776E62h ¥ 5443301Ch X 08F3DECBN ¥ BaAasAsrh X_asa1a80a1h ) acaFeAsah X BeCBDFEah

4 _ort_layer DAC3BRFA2_84111 jesd_transport1|dds ddsi0|fsin_of15.0] {__3acCzh 72DFh ZDaih saash X__osaah BaBFh___X___86BFh saDAh__Y__Bsosh osaoh
5 _ort_layer DAC3BRFS2_84111:jesd_transport] |dds-ddsil |fsin_o[15._0] {__aAR1h Asah BCh az73h X Faach X Asazh Baboh afaih Chaah 102An
4 _ort_layer DAC3BRES2 84111 jesd_transport] |dd:  o[15.0] {__sAan ZEECh aECan Zoboh ¥ DEmzn 2AsAh in aAath DEoah rFIT
4 _ort_layer DAC3BRFS2_84111 jesd_transport|dds ddsi3|fsin_o[15.0] ZFi 7h Fi = PYTTY

‘jesd204 tx pcs data’ shows the 256 bits of data which will be sent to DAC serially,

It is grouped as 32 bit buses so that each bus corresponds to data of a single lane.

‘jesd204 tx link data’ shows the 256 bits of data which is formed by rearranging the

data generated by the DDS module so that it suits 84111 mode of DDS,
It is grouped as 32 bit buses so that each bus corresponds to data of a single lane.

‘ddsi*|fsin_0’ shows the 16
generated by the DDS modul

bits of sample data (sine wave of 20 MHz) which is
€.

It is possible to view the output of each DDS as a 20 MHz wave, within the chipscope.

The procedure:

1. Right click -> Bus Display Format -> Signed decimal in Two’s Complement

log: Trig @ 2017/12/28 0718352 (00309 slapsed) |
Type| Auas Name Jare a2 a1 aqa 415 aie H e s 430 Az
[ _sysref
o _sync_n
=i xevr_jesd_ncio_xcvr_jesd_rx|jesd204_t_pcs_datal255..0]
- # xcvr_jesd_ncio_xcvr_jesd_rx|jesdz0s_tx_pcs_datal255..224] BEZEA7DN X 63DOGISAN X_122BECE1IN X SEEOFAJON X 238FB1Czn X FCECBAaDEn X D7C4BCa1n X EAD673450 X 06B74Ca+n AGZBEN
- * xovr_jesd_nciO_xcvr_jesd_rx|jesdzo4_tx_pcs_datal223..192] 251 . IE7EZAT 26E777DN AASpan
- + xcvr_jesd_nci0_xcvr_jesd_rx|jesdz04_tx_pcs_data(191.160]
= * xcvr_jesd_nciO_xcvr_jesd_rx|jesd204_tx_pcs_data(159..128) DAES B BSA4AA3E A o SFRAA y
= # xovr_jesd_n<iO_xcwr_jesd_rx|jesd204_tx_pcs_data[127..96] {2B525870n X 04D0634AN X_1225ECE1h X AFEQFAION X_238FB1C2h X_FCECEADFN X DZC4BCa1n X E8DG73450 X 0GB74Ca4h X ORSAGZBED )
= # xovr_jesd_nciO_xcwr_jesd_rx|jesd204_tx_pcs_data[95..64] {e0B48BESh X 238983FCh X_D3COAERFh X 2510FBEZh X G85A4A3EN X _7E7EZA72h X 626E7770h X_1C304354h X CBDEF30an X SFRAASBAN )
3 ¥ xewr_jesd_nciO_xcvr_jesd_rx|jesd204_tx_pcs_data(63.32] BO525870N X 64D0634AN X_1225ECE1h X_4FEOFA30N X _238FB1C2h X_FCECBADFD X D7C4BCA1h X EAD67345h X.08074Cash X 0BsAG2AFh
= 4 xewr_jesd_nci0_xcvr_jesd_rx|jesd204_te_pcs_data[31.0] BoBa8Bosh ¥ 938983FCh X D3COAESFh X_2510FBEZh X aasAsAssh X 2F7EzAzzh X 626E7770h X 1C30435h X CBOEFa0ah X aFeadaBan
= _ayer DAC3BRFS2_84111:jesd_transport] |jesd204_tx_link_dsta[255..0]
% _C38RF82_84111jesd_transportl|jesd204,_tx_link_data[255..224] ( 30FAEO4Fn ¥ C2B18Fz3n ¥ DFasECECh X 81BCCaD7h X a573D6Ean X 333Ch706n X BF625A00n Y BFB001BER X DA318EAOh X 065209800,
+ _C38RF82_84111jesd_transporti|jesd204_tx_link_data[223..192] (E7FB1025n 727A7E76n X 7D776E62n X 54522010 X 0aFa0ECER h Xasaiaoain EeAsan X BRCBDEFaN
# . C38RF82_84111;jesd_transporti|jesd204_tx_link_data[191..160] { 30FAE04Fn X C2B18F23n X_DEBBECECH X 81BCCaD7n X a57306E8n X 324CB706n X BEG. oh X_BEBO01BER X DA318EADh X 06520980N0
® . C38RF82_84111jesd_transportl|jesd204_tx_link_data[159..128] (E7FB1025n 22747E7¢n X 70776E62n X 5443201Cn X 08F3DECHN n X aca1sca1n X asaFeasan X BeCBOFEan
# . C38RFE2_84111:jesd_transportl|jesd204_tx_link_data[127..96] (20FAtosfn X C2B1erzan X DE@RECECh X 818CC407n X 25730680 X assCo7oon X BFezsaoen X BrBo016En X DA318EAoh X 06520880N
+ _AC38RF82_84111jesd_transport |jesd204_tx_link_data[95.64] (EzFBiozsn AZEZFh X 7D776E62n X 54433010 X 08F3DECEN X BoAnsAarn X 860180810 X a68FeAAan X BeCBDFERN
+ . AC3IBRF82_84111:jesd_transportl|jesd204_tx_link_datal63..32] { 30FAE04Fn X C2B18F23n X_DFEBECECh X 818CC407n X 457306680 X 34487060 X BF62sA0en X_BFBO01BEN X DA31BEADH X 06: on|
+ _DAC3BRF82_84111:jesd_transport1 |jesd204_tx_link_data[31.0] {EzFBiozsn 27A7E76n X ZD770E02n X s443301Cn X o8raDican X paassastn X acaisoain BCBOEFan
= + _ort_layer_DAC38RF82_84111:jesd_transport1|dds:ddsio|fsin_o[15..0] 14530 2840 3z128 1573 100 X -1@z2a1 31041 31014 18170 z1
- + _ort_layer_DAC38RF82_84111:jesd_transport |dds:ddsi1|fsin_o[15..0] 12121 31308 300 1720 X 130 32330 as7n 348 asz
P + _on_layer_DAC38RF82_84111:jesd_transport |dds: _o[15..0 319 32482 83 1250; 8521 X 50; 3270 25970 gaz0 1z
- # _ort_layer DAC3SRFS2_84111;jesd_transport1|dds ddsi3|fsin_o[15 0] 2 22 3171 (17238
e We can plot the samples of any dds instance ouput(fsin_o) and we should get a sine wave as

follows(plot of ‘ddsiO|fsin_o[15:0]’)



Samplel 14530 y
40000 #
Sample2 29407 &
Sample3 32129 30000 Y
Sampled 21573 20000
Sample3 2100
Samples -18241| | 10000
Sample7 -31041 0
Sampleg -31014
-10000
Sampled -18170
Sampleld; 2185 -20000

-30000

-40000

4. Scope and Spectrum Analyzer

The frequency as seen in the Scope output:

Display Capture ( Terminal D C (A

CH1

Vpp
992.6mU

CH1
Yimax
114U
CH1
Ymin
1 36.0mV
CH1
Period
S216ns
CH1

Freq
1.1 SMHz

CH1= 200mV M 186.0ns / 3.0
M Pos:0.00ps 18-01-8812:59:33

Note: As we used DAC 38J82 at lane rate 7.3728G instead of DAC38RF82 at lane rate 7.68G
Sampling frequency will be 184.32 MHz instead of 192MHz, Hence the output frequency is
19.2MHz instead of 20 MHz



The frequency as seen in the Spectrum Analyser:

Start Freq (200 Hz) ~ Stop Freq (3.5¢9 Hz) A
1M : 100m : resource name out

1
GPIB0::20:INSTR L GPIB0::20:INSTR
% = Ref Level (0.0dBm

VISA resource name

10 =

1
20.0000M  30.0000M 4000000 50,0000M  60.0000M  70,0000M  80,0000M  90.0000M  99.8020M

. error out
error in (no error)

tat d status code
status code

,. y
Qf? IJ 0 source
source . ‘

V. FIRMWARE INFORMATION

This FW (and Transport Layer) has been made specifically for 84111 mode. A sinewave is
being generated within the FW. This Sine wave is being sent continuously (free-running) to
the DAC from the FPGA.

1. Generation of Sinewave:

e A DDS Compiler is being used within the FW in order to generate the Sinewave. In
this design, a Sine wave of frequency of 20 MHz is being generated.

e The DDS compiler will require a sampling clock as input. In this firmware, the
sampling frequency of the DDS compiler is 192 MHz

e For every link clock cycle we need to send 32 bits of data to the JESD Base IP. Hence
we use 4 instances of DDS compiler modules to generate 4 waves of 20 MHz each.
However each instance is offset by an equal value (for this mode the phase offset is
one-fourth of the output wave i.e., 20/4 = 5Mhz) such that in each link clock 4



samples of a 20 Mhz Sinewave is generated. All four of these samples are
concatenated (jesd204_tx_link_data signal) and given as an input to the JESD base IP.

e The concatenated output (jesd204_tx_link_data) consists of four 16-bit samples. In
this mode 4 samples are divided across 2 lanes for every clock cycle. Hence the
output of the transport layer is a 256 bit bus, which contains sixteen 16-bit samples
for 8 lanes.

e The DAC sampling rate for this lane rate (7.68G) is 768 Msps. Each DDS Compiler
instance generates a 20 MHz wave w.r.t a sampling rate of 192 MHz Therefore when
we combine the outputs of 4 of such instances for a single cycle, a sine wave of 20
Mhz is generated for a sampling rate of 768 Msps.

e In this design, the DDS compilers generate a free running sine wave output. Hence
every clock cycle is a start of frame. Thus the output of the transport layer is directly
connected to the JESD TX Base IP.

2. Changing the Sine wave frequency:

e In order to change the generated Sine wave frequency, we need to change the phase
offset and phase increment values.
(calculation has been presented for 20 MHz sine wave case)
o Phase offset = [2*Phase width /(Sampling frequency/Required frequency)]/4
= [2732/(192/20)]/4
= [4294967296/9.6]/4
= 447392426.667/4
=111848106.6667
By rounding off to the nearest integer we get 11184810707 which is
6AAAAAB in hexadecimal.

o Phase increment = 2"Phase width /(Sampling frequency/Required frequency)
= 2/32/(192/20)
= 4294967296/9.6
= 447392426.667
By rounding off to the nearest integer and making it a multiple of phase offset,
we get 447392427 which is LAAAAAAB in hexadecimal.

For more detailed information about the DDS compiler module please refer to the Altera
document available at the following link:

https://www.altera.com/en US/pdfs/literature/ug/ug nco.pdf



https://www.altera.com/en_US/pdfs/literature/ug/ug_nco.pdf

File Edit System Generate View Tools Help

% IP Parameter Editor - dds.qsys™ (C:\Soliton_Work\Chinna\Ref Design 4 T4R\Testing\281217\for_release\A10_DAC38RF82_84111_7 68G_restored\ip\dds.qsys)

W parameters 5% |

- ==

ooz [EEENREE o o

System: dds  Path: nco_i 0
NCO

altera_nco_i

(] show signals

Ien |
hi_inc_i[31..0 | :
hase_mod_i[31.0] | .
atterd

< [

| Architecture | Frequency | optional Ports | 510 Optimization

~ Precisions

Phase Accumulator Precision: |32] bits

Angular Resolution: I bits

Magnitude Resolution: 16 bits
|~ Phase Dithering

Implement Phase Dithering
Dither Lavel: 5!
2 a & s

~ Generated Output Frequency Parameters

Clock Rate: 192.0 MHZ

Desired Cutput Frequency: | 20.0 MHz

Phase Increment Value: 447392427

Real Qutput Frequency: 20.0 MHz
Frequency Domain | Time Domain |

Magnitude (dB)

Type Path Message

(Mol Precets o | - =

<[

Presets for nco_ii_0
4 >
Project
Click New.... to create a preset.
Library
f-No presets for NCO 16.1

Apply Update Delete

0 Errors, 0 Warnings

Generate HOL... | [ Finish

File Edit Systern Generate View Tools Help

5. IP Parameter Editor - dds.qsys™ (C:A\Soliton_Work\Chinna\Ref Design 4TAR\Testing\281217\for_release\A10_DAC38RFE2_84111_7.68G_restorediipidds.qsys)

9 Parameters 5% |

- = o

e [EEEEREE] _—o

System: dds  Path: nco_ii_ 0O
NCO

altera_nco_ii

Architecture | Frequency | Optional Ports | s10 oy

Modulator Resolutions bits
Modulator Pipeline Level:
[~ Phase
Phase Modulation Input
Modulator Reselution: |32 bits

Modulstor Pipeline Level: |1

Frequency Demain | Time Domain

Magnitude (dB)

Type Path Message

<[

[#] show signals

nco_ii_0

fsin_o|

rs out_vaa
set_n n

lken
hi_inc_i[31_0] o inc_i

hase_mod_[31.0] | 0L

atters]

< i ]

Cwa —or o

Presets for nco_ii_0
4 x
Project
Click New... to create a preset
Library
No presets for NCO 16.1

Apply Update... Delete

0 Errors, 0 Warnings

Generate HDL... | [ Finish

V. STATUS LEDS

Two signals have been added in the top module for debugging

link_clk_led: This signal indicates if the link clock (lane rate/40 clock) from ADC is available
or not. It will be blinking at the rate of about 6.4 Hz

tx_altsyncn_led: This signal refers to the SYNC input to JESD Base IP and is given to LED
D6 on board. It will be ON if SYNC is lost. Under normal process, this LED will be OFF

Note: Both the LEDs are active low



